This list shows the CDs that were found in the MS CD player database.



Choose the report type here:

- CD list (portrait) : a list showing only the basic CD info

- CD list (landscape, popular) : a list printed in landscape orientation with fields interesting for popular CDs.

- CD list (landscape, classical) : a list printed in landscape orientation with fields interesting for classical CDs.
- CD cards : all CD fields, including tracks and cover picture, arranged as cards.



The order of the CDs on the report.



This shows the filter that will be used for the report.



Click this to modify the report filter.



Check this to preview the report on screen.



Registration Form

Keep it Compact 1.1 Registration Form

First name

Last name

Address

City

State/Country

E-mail adress

(CompuServe or Internet)
Send to:

KiC Registration
Alwin Hoogerdijk
P.O. Box 9660
3506 GR Utrecht
The Netherlands



Choose the Zoom factor here. Type the new factor directly in the box or change the factor using the up and down buttons.



The statusbar shows the current page number and the total number of pages.



How to Register

Shareware
Keep it Compact is shareware. The shareware version is fully functional with the only restriction that the number of CDs is limited to 15. This
way you can evaluate all features of KiC before actually buying it. If you like KiC and want to keep using it, you will have to register.

Registration

When you register you will receive a registration key. With this key you can register your copy of KiC and thus remove the 15 CD limit. This key
can also be used to register future versions of KiC.

The registration fee is only 25 US dollars or f 35,- in Dutch guilders..

Check out the Keep it Compact homepage on the World Wide Web for the latest KiC registration info:
http://www.inter.nl.net/users/J.W.Hoogerdijk/KiC

There are three ways to register (in order of preference):

1. CompuServe SWREG
The easiest and fastest way (for you and for me) is to register via the CompuServe SWREG service. The Keep it Compact SWREG Registration
ID is 11396. You will receive your registration key via CompuServe mail.

2. Overmaken (the Netherlands only)

People in the Netherlands can transfer an amount of f 35,- to account 38.34.59.125 at the Rabobank in Utrecht. In dutch: U kunt f 35,- overmaken
op bankrekening 38.34.59.125 (Rabobank Utrecht) t.n.v. J.W. Hoogerdijk o.v.v. "KiC registratie". Voor mensen met alleen een girorekening: het
gironummer van de Rabobank Utrecht is 254134.

The registration key will be sent by regular mail (unless you let me know your E-mail address).

3. Cash or check (only Eurocheques, travellerscheques and "girobetaalkaarten")

Because bank charges on cashing foreign checks are very high (if I manage to cash them at all) I can only accept Eurocheques, travellerscheques
and "girobetaalkaarten" (dutch). Checks must be made out to J.W. Hoogerdijk. The amount (cash or check) can be either in US dollars ($ 25) or in
Dutch guilders (f 35,-).

If you use this method of registration please print and fill out the Registration Form. If you can be reached by E-mail (either CompuServe or
Internet) fill in your address and you will receive the registration key by E-mail. Otherwise it wil be sent to you by regular (snail) mail.

Send cash/check and registration form to:

KiC Registration
Alwin Hoogerdijk
P.O. Box 9660
3506 GR Utrecht
The Netherlands

After registration

For clarity: When your registration and payment is received, you will be sent a registration key only. You will not receive disks/E-mail with
another KiC version. You already have the full version, it is only limited to 15 CDs. With the registration key you can remove this limit. The key
will also work with future KiC versions.

To use your key, start KiC, choose File | Register and the Register dialog appears. Fill in your name and registration key, click Ok and your copy
of KiC is registered!



What is Keep it Compact?

Keep it Compact (KiC) is a Windows 95 application for cataloging your audio compact discs. It lets you store lots of information about your
CD’s. Not only the basic fields like Artist, Title and Tracks, but also Year of release, Studio, Producer, Label, Catalogue number and Genre. It can
even store a picture of the CD cover. Extra comments can be typed in the Comments field. KiC has special support for classical CD’s (Composer,
Conductor, Orchestra, Soloists, AAD/ADD/DDD) and live CD’s (Mono/Stereo, Live/Studio, Recording data, Tourname).

Entering all your CD's is too much work? Don't worry, KiC has been designed to make adding CD’s to the database as quick and easy as possible.
It uses the CD-rom drive to scan your CD’s. Just put the CD in the drive and let KiC read the track info (number of tracks, all track lengths, CD
length and serial number). Then use the optimized data entry interface to enter the rest of the information. KiC makes this as quick as possible by
providing lookup lists for most of the fields.

You already entered all your CD's in the Windows 95 CD player? No problem, use the KiC import function and you can start using KiC. You still
want to use the Windows 95 CD player as your player? Then use the KiC export to update your CD player database once in a while.

Other KiC features:

- enter multi-disc CD sets as one entry in the database by adding disc-headers to the tracklist.
- support for compilation CD’s by providing an Artist field for each track

- add extra headers in the tracklist e.g. for composition titles

- print 4 different reports of your CD list

- use filters to view or print only part of the database

- find CD’s and tracks by providing only a part of the title

- find CD that is currently in the CD-rom drive

KiC is shareware. The shareware version is fully functional with the only restriction that the number of CD's is limited to 15. Registration is only
25 US dollars. When you register you will receive a registration key which you can use to register your copy of KiC and remove the 15 CD limit.



About the author

I am Alwin Hoogerdijk, the author of Keep it Compact. I can be reached via the Internet, via CompuServe or by regular (snail) mail. So if you
have any questions, comments or suggestions, let me know. Please also report any bugs you might find.

Internet E-mail:
jhoogerd@inter.nl.net

CompuServe mail:
101467,142

Regular mail:
Alwin Hoogerdijk
P.O. Box 9660
3506 GR Utrecht
The Netherlands

Also check out the Keep it Compact homepage on the World Wide Web:
http://www.inter.nl.net/users/J.W.Hoogerdijk/KiC



During the import, this bar shows the progress.



This statusbar shows the following information:

- CDs found: The number of CDs found in the MS CD player database.

- CDs imported: The number of CDs that have been added to the KiC database.

- CDs skipped: The number of CDs that were not added to the KiC database because they were already there.
- Artists added: The number of new Artists that have been added to the KiC Artist list.



This list shows the CDs in the KiC database that were scanned using a CD-rom drive. Only these CDs can be exported to the MS CD player,
because the CD player needs the CD serial number.



During the export, this bar shows the progress.



The statusbar shows the following information:

- CDs found: The number of scanned CDs that were found in the KiC database.

- CDs added: The number of CDs that have been added to the MS CD player database.

- CDs updated: The number of CDs that have been updated in the MS CD player database.



By default KiC asks for confirmation when you remove CDs from the database. Uncheck this if you don't want the "Are you sure...?" questions.



By default KiC asks for confirmation when you remove tracks from the database. Uncheck this if you don't want the "Are you sure...?" questions.



Choose here which CD player you want KiC to start when you click the "Start CD player" button on the toolbar. By default KiC start the
Windows 95 CD player.



Choose the CD-rom drive you want to use for scanning CDs. By default KiC uses the first CD-rom drive in your system.



Enter the registration name that you received. Be precise, otherwise the name won't match the key.



Enter the registration key that you received. Be precise, otherwise the key won't match the name.



This listbox shows the current contents of the lookup list.



Add an item to the lookup list. Opens a dialog where you can enter the new item. Keyboard shortcut: Insert.



Edit the item that is currently selected. Opens a dialog where you can edit the item. Keyboard shortcut: Enter.



Remove the currently selected item. This is only possible when the item is not referenced anymore in a CD record. Keyboard shortcut: Delete.



Check this checkbox to enable the filter.



Specify a range of years here. To enable this filter, first check the checkbox on the left.



Choose AAD, ADD or DDD. To enable this filter, first check the checkbox on the left.



Choose an item from the dropdown list. To enable this filter, first check the checkbox on the left.



This list shows the tracklist that was scanned from the CD-rom drive.



Add the tracks showing in the track list to the track list of the current disc. If the tracklist already contains tracks, this action just updates the track
lengths.



Rescan the CD in your CD-rom drive. Use this button to refresh the track list.



This panel shows the number of tracks found on the CD and its total length.



Enter the track title here.



Enter the track length in minutes. If you scan your CDs using your CD-rom drive, you won't need this field.



Enter the track length in seconds. If you scan your CDs using your CD-rom drive, you won't need this field.



Press the Next button to confirm the track info and go to the next track without closing the dialog. Keyboard shortcut: Enter.



Press the Done button to confirm the track info and close this dialog.



Choose an item from the dropdown list. Use the ellipsis-button on the right to add new items.



Use this button to open the lookup list dialog, where you can add items to the lookup list on the left.



Enter the release year here. This field only accepts numeric characters.



Enter the CD title here.



This is the tracklist of the CD. Items can be moved by dragging. Discs and headers can be edited by selecting them and then clicking them, just
like in the Explorer.



Add a new disc to the tracklist. Discs are always added at the end of the list. Change the title of the disc by selecting it, then clicking it again.



Add a new header to the tracklist. Headers are always added at the end of the current disc. Change the title of the disc by selecting it, then
clicking it again.



Add a new track. This opens the Track dialog, in which you can enter the track title and length. From the Track dialog you can add multiple tracks
by using the Next button. New tracks are always added as the last track within the current header or disc. Keyboard shortcut: Insert.



Edit the currently selected disc, header or track. Discs and headers are edited in place, editing tracks is done in the Track dialog. Edit multiple
tracks by using the Track dialog Next button. Keyboard shortcut: Enter.



Remove the currently selected disc, header or track. Please note that removing a disc or header also removes all items that are below it. Keyboard
shortcut: Delete.



Scan tracks from the audio CD in your CD-rom drive. The scanned tracks are added to the current disc (or the tracks of the current disc are
updated).



Expand all items in the tracklist making all headers and tracks visible.



Collapse all items in the tracklist, so that only the toplevel items are visible.



Total number of tracks on the CD.



Total length of all tracks on the CD.



Check this for mono CDs.



Check this for live CDs.



Choose AAD, ADD or DDD here. This field defaults to DDD.



For live CDs you can enter the recording date here.



For live CDs you can enter the tour name here.



This field is for the CD's catalogue number.



This picture shows the CD's cover. This field can be filled by pasting a picture from the clipboard or loading it from disc.



Use this button to paste a picture from the clipboard into the cover field.



Use this button to load a picture into the cover field from disc. Opens a file dialog.



This field is for comments. Use it for information you want to store with the CD but for which KiC has no special field.



This fields is for entering the soloists/musicians that play on this CD.



Date of purchase of this CD.



How much you paid for this CD.



Purchase location (e.g. store)



Credits

I want to thank the following people for their help in making KiC what it is now.

John Pragasam : For all his good suggestions, for his knowledge of classical CDs, for his elaborate testing and his detailed test reports. Thanks
John.

Martin Westendorp : For the original concept of a specialized compact disc database system.

Syts : For dragging me from my PC once in a while, making sure I got some sleep.



The main screen

On the Keep it Compact main screen there are two possible views: List view and Browse view. You can switch between these views by clicking
on the List and Browse tabs.

The List view displays a list of all CD's, showing all CD fields. You can resize the columns by dragging the separators. You can even change the
order of the columns by dragging them. KiC remembers the column layout between sessions.

The Browse view shows all fields of one CD at at time, including the track list. Browse through your CDs using the set of Browse buttons on the
right of the toolbar. The track list is fully user configurable too. The fields resize when you resize the main window so you can take advantage of
you high resolution screen.



Cover and Comments windows

The Cover and Comments windows are separately floating windows that show the Cover picture and the Comments field of the currently selected
CD in the CD list. These windows can be shown (and hidden) by choosing "Show cover" or "Show comments" from the View menu.

The Cover window has two operating modes:

- Resize window to picture : the windows grows or shrinks to accommodate the size of the cover picture.

- Stretch picture to window : the picture is stretched to fit the window.

Right-clicking on the Cover window pops up a menu where you can switch between these modes.

The third item in this popup menu is "Stay on top". Check this and the Cover Window will always stay on top of the main KiC window. This can
come in handy if you work with KiC maximized on your screen.

The "Stay on top" effect is also available for the Comments window. Right click the window and check "Stay on top" in the menu that pops up.



Adding, editing and removing CDs

Adding CDs

You can add a CD to the KiC database by:

1. Choosing: "Add new CD" from the CD menu

2. Clicking the corresponding button on the toolbar (first button on the left)

3. Using the Insert key

All methods open the "Add CD" window where you can enter the info for the New CD. After closing this window the new CD will be selected in
the list.

Editing CDs

There are four ways to open the "Edit CD" window for editing a CD in the list.

1. Select it and choose "CD | Edit selected CD"

2. Select it and click the Edit CD button on the toolbar (second button from the left)
3. Select it and press Enter.

4. Double click the CD in the list.

Removing CDs

Removing a CD is done by selecting it first and then:

1. Choosing "CD | Remove selected CD"

2. Clicking the Remove CD button (third button from the left)

3. Pressing Delete.

By default KiC asks for confirmation when you remove CD's. You switch this off in the Options dialog.



Edit/Add CD window : Introduction

This window consists of six tab sheets:

- Main : Identifying Fields

- Tracks : Track list

- Recording : Info about the recording

- Extra : Info about the purchase and other fields
- Cover : CD cover picture

- Comments : Comments field



Using lookup fields

One of the KiC features that make entering CD data as quick as possible is the presence of lookup fields.

An example of a lookup field is the Artist/Composer field. Entering a value in a lookup field is done by opening the dropdown list and selecting a
value from the list.

If the value you want is not in the dropdown list yet, you can add it by clicking the "..." button on the right of the lookup field. This opens the
lookup list dialog. After adding the desired value to the list, close the dialog and the new value will be automatically selected.

The use of lookup fields has a number of advantages:

- Selecting from a list is quicker than typing, so if you use an item in multiple CDs, you will only have to type it the first time. After that, you can
just select it from the list.

- The lookup items are stored in the database only once. Each time you use it in a CD, the CD record only stores a reference to the item and not
the item itself. This way, changes you make to the item will be automatically reflected in all CDs where you used it.

Removing lookup list items
You can not remove lookup list items when they are still used in CD- or Track-records. KiC checks this each time you try to remove a lookup list
item.

Maintaining the lookup lists can also be done outside the Add/Edit CD window. From the main screen, choose one of the menu-items in the Lists
menu. These bring you directly to the Lookup list dialog for the specified lookup list.



About the track list

Keep it Compact makes it possible to store multidisc CD sets as a single entry in the CD database. Another feature is the possibility to add track
headers to the track list, grouping of set of tracks. This can be used for composition titles of classical CDs.

Both features are results of the 3-level tracklist. The tracklist is displayed in a so-called "tree-view". Another example of a tree-view is the left
pane of the Windows Explorer.

To view the entire track tree, click the Expand all button (Alt-E). Click Collapse All (Alt-C) to collapse the tree again, so that only the top level
items are visible.



Adding tracks by scanning CDs
Keep it Compact can automatically add tracks by scanning a compact disc in your CD-rom drive. It also reads the track lengths from the CD.

Scanned tracks are alway added to the currently selected disc. So before scanning, first select the disc item below which you want to add the new
tracks (or select one of its sub-items). If you're not using disc-items, it doesn't matter what is selected.

Scanning is started by clicking the Scan button (or pressing Alt-S). This opens the Scan dialog. The list shows the tracks found on the CD (if not,
just press the Rescan button).

To add these tracks to the track list, click the Use button (or press Enter). If the current disc already contained tracks, the track lengths of the
existing tracks are updated.

Scanning a CD also fills the CD serialnumber field. This is an invisible field that is stored for each CD (or for each disc within a CD). The
serialnumber field is used in the Find CD by scanning function and for exporting to the MS CD player database (the CD player also needs the
serialnumber for recognizing CDs).



Choosing the sort order

The CD list on the main KiC screen (List View) can be sorted in four different orders. You can switch between these orders by checking one of
the "Sort by..." menu-items in the View menu or by clicking one of the Sort buttons on the toolbar (the second group of buttons from the left).

The possible sort orders are:

Order by Artist/Composer (ascending)
Order by Artist/Composer (descending)
Order by Year (ascending)

Order by Year (descending)

These orders are also available when printing reports.



Filtering the CD list

Keep it Compact makes it possible to show only a subset of the database contents in the CD list on the main screen. This is done by specifying a
filter. The currently active filter is always displayed in the rightmost section of the KiC statusbar.

Specifying a filter is done in the Filter dialog. Open this dialog by choosing the Filter item from the Search menu or by clicking the Filter button
on the toolbar.

The Filter dialog shows a number of possible filter fields. To active a filter field, first check the corresponding checkbox and then specify a filter
value. If you activate multiple filter fields the filter conditions will be "ANDed". For example: Label=EMI AND Genre=Rock.

The same Filter dialog is used for specifying a filter for printing reports.



Searching for a CD or track

Keep it Compact offers various ways to find a specific CD in the database:

- By typing part of the CD title. Choose "Search | Find CD | by Title"

- By specifying (part of) its number. Choose "Search | Find CD | by Number"

- By putting the compact disc in your CD-rom drive and letting KiC scan it and find it. Choose "Search | Find CD | by scanning"

The fourth method is called Global Search and searches all fields of the CD and its tracks for the search text you specify. Use this only if you
want to find occurences of a text and you can't do it by using filters, since this method might be slow. Start a Global Search by choosing "Search |
Global Search".

Finding a track can be done by typing part of the track title. Choose "Search | Find Track by Title".



Creating a report

To create a report of the contents of the CD database, choose "File | Reports". This opens the Report dialog.
In this dialog you can define how you want your report printed and which CDs you want to appear on the report.

Report type
You can choose between four report types. For a description of the report types, click here.

Order by
This sets the order of the CDs on the report. The possible orders are the same as on the main screen.

Filter
If you do not want all CDs to appear on the report, but only a subset, specify a filter here. Click the Change Filter button to open the Filter dialog.

Preview on screen first

If this checkbox is checked, a preview of the report appears on screen first. In the preview window you can browse through the pages of the
report.

If you want to print directly to the printer, uncheck it.



Report Types

CD list (portrait)
A list printed in portrait orientation showing only the basic CD info, one CD per line. The fields that are printed are:
Artist/Composer, Title, Year, Length, Label and Number.

CD list (landscape, popular)
A list printed in landscape orientation with fields interesting for popular CDs, one CD per line. The fields that are printed are:
Artist, Title, Year, Length, Label, Number, Studio/Concert Hall, Producer/Engineer and Recording.

CD list (landscape, classical)
A list printed in landscape orientation with fields interesting for classical CDs, one CD per line. The fields that are printed are:
Composer, Title, Conductor, Orchestra, Soloists, Label, Number, Year, Length.

CD cards
All CD fields printed in portrait orientation showing all CD fields, arranged as cards. This report includes a full track list, the comments fields and
even the cover picture.



Importing from the CD player database

You already entered all your CDs into the MS CD player database? Don't worry. Use the KiC import function ("File[Import from MS CD player")
and you can continue working with KiC.

The Import dialog shows the CDs that were found in the CD player database. During the import all these CDs are imported into the KiC database,
skipping CDs that are already present. KiC automatically adds new Artists to the Artist list if needed.

Note that for freshly imported CDs only the Title, Artist and Track titles are filled in, since this is the only info stored in the CD player database.



Dragging and dropping

The track list can be manipulated by dragging and dropping items.

If you drag an item, it can only be dropped on items with the same level or items with an higher level.
So:

Tracks can be dropped on tracks (to change the track order), on headers and on discs.

Headers can be dropped on headers (to change the header order) and on discs.

Discs can only be dropped on discs (to change the disc order).



Exporting to the CD player database

You still want to keep using the MS CD player for playing CDs? No problem. Just periodically update the CD player database from the KiC

database with the KiC Export function ("File|Export to MS CD player").
Since the MS CD player needs the CD serial number, you can only export CD records that include the serial number, that is, CD records that were

entered by scanning. So the Export dialog only shows scanned CDs. During export all scanned CDs are exported to the CD player database,

updating CDs that are already present.
Note that multi-disc CDs get exported as separated CDs. The disc titles are appended to the CD titles to form the new CD titles in the CD player

database.



Starting the CD player

To make using the MS CD player still easier, you can start it from the KiC toolbar. If you want to use another CD player, you can select one in the
Options dialog ("File | Options").



Importing your KiC 1.0 database

If you have been using KiC 1.0 in the past, you can import your data into KiC 1.1. Choose "File | Import KiC 1.0 database" and KiC 1.1 will
automatically find your KiC 1.0 database directory. Confirm the database location and the import is started.
During import a progress window will shows the status of the import process.



Packing the database

KiC uses a Paradox database. Because Paradox databases don't automatically free up space after removing records, they need to be packed once

in a while. KiC lets you do this easily with its Pack database function (in the File menu).
After choosing the menu item, confirm that you want to pack now and the packing starts. When the progress bar reaches the end, you'll see a

"Packing complete” message and you're done.



Adding items to the track list

Adding discs

The easiest way to enter multiple discs in the track list is by creating the disc items first and then adding tracks below the disc items. So:
1. Click New disc

2. Rename the disc item (just like the Windows Explorer). Default name is "New disc"

3. Select the item (if necessary)

4. Add tracks to the disc (either manually or by scanning, explained below)

Adding headers

Again, using headers is easiest when the headers are created first.

1. If applicable, select the disc item below which you want to place the header.
2. Click New header

3. Rename the header item

4. Add tracks below the header

Adding tracks

Adding tracks can be done manually of by scanning a compact disc in your CD-rom drive. Scanning is by far the easiest and quickest method.
For more info about scanning, click here. Addings tracks manually is done like this:

1. Select the disc- or header-item below which you want to place the tracks.

2. Click New track or press Insert (the Track dialog opens)

3. In the Track dialog, fill the track fields and click Next (or press Enter)

4. Repeat step 3 until you entered all tracks, then click Done (or press alt-D)



Editing items in the track list

Editing disc- and header-items
Disc- and header-items can be edited in place. Just select the item and then click it again (like in the Windows Explorer). You may also click the

Edit button to start in place editing.

Editing tracks
To edit a track, select it and then click Edit. This opens the Track dialog in which you change the contents of the track fields. You can edit

multiple tracks without closing the dialog by choosing the Next button (or pressing Enter). Click Done when you're done.



Removing items from the track list

Removing disc- and header-items
Remove disc- and header-items by selecting it and clicking Remove (or pressing Delete). Beware that removing a disc-item or header-item also

removes all items below it. KiC gives a warning if you try to do this.

Removing tracks
To remove a track, select it and click Remove (or press Delete). Confirm the removal and the track is removed from the list. You can switch off

the confimation question in the Options dialog ("File | Options").



Where to get the cover pictures?

You might ask yourself "I really like it that KiC can store pictures of CD cover, but I don't have a scanner. How do I get the cover pictures for my
CDs?"

The answer is simple: the Internet
Many artists have one or more homepages dedicated to them.

Some starting points:

http://www.yahoo.com/Entertainment/Music/Artists/
http://a2z.lycos.com/Entertainment_and_Leisure/Music/Pop_Artists_A2Z/
http://a2z.lycos.com/Entertainment_and_Leisure/Music/Composers/









